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Legal

Copyright © Megapixel®.

HELIOS OptiTune™ is a trademark of H2VR HoldCo, Inc.

The Megapixel™ logo is a trademark of H2VR HoldCo, Inc. Other trademarks and trade names may be used in this 
document to refer to products by other entities. Megapixel claims no proprietary interest in trademarks and trade 
names owned by others.

Information and specifications in this document are subject to change without notice. Megapixel assumes no 
responsibility or liability for any errors or inaccuracies that may appear in this manual.

Contact

+1 818 884 5488

http://megapixelvr.com

Warranty Information

Megapixel does not warrant that the operation of the product will be uninterrupted or error free. Megapixel is not 
responsible for damage arising from failure to follow product or installation instructions.

Compliance With  QT LGPL

HELIOS OptiTune uses Qt framework under the terms of the GNU Lesser General Public License v. 3 ("LGPL"). In 
compliance with LGPL, this document collects the relevant information about downloading, installing, and building 
Qt framework from sources. The main source of the information and most of the web links provided here come 
from the Qt Company's website.

Note: Qt is copyright by The Qt Company and/or its subsidiary(-ies) and other contributors.

LGPL License Text

The first step in compliance with LGPL is that every recipient of the OptiTune software receives also the full text of 
the LGPLv3 license used. HELIOS OptiTune complies with this requirement by including the full text of the LGPL 
license (Qt-LICENSE.txt) in every OptiTune distribution.

The full text of the LGPLv3 license can also be obtained on the GNU website.

How HELIOS OptiTune Uses Qt

Dynamic Linking

On each supported platform (Windows, and MacOS), HELIOS OptiTune dynamically links On each supported 
platform (Windows, and MacOS), HELIOS OptiTune dynamically links against compiled QT libraries, from 
unmodified source provided by the Qt Company.

https://www.qt.io/
https://www.qt.io/
https://www.qt.io/
https://www.gnu.org/licenses/lgpl-3.0.en.html
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Also, in compliance with LGPL, the "Help - About - About Qt" dialog box inside the HELIOS OptiTune application 
prominently states that this program uses the Qt framework under the terms of LGPL.

Qt Version Information

Additionally, there is "Help - About - About Qt" dialog box, which informs the user about the exact version of Qt 
and explains the Qt licensing terms.

Qt Library Source Code

HELIOS OptiTune uses Qt version 6.3.0. It uses LGPLv3 license. 

Qt 6.3.0: https://download.qt.io/archive/qt/6.3/6.3.0/

Written Offer to Provide Source Code

In case you have any trouble downloading the Qt Source Code from the official links provided above, we make 
hereby a written offer to provide such source code to you. To make a Qt source code request, send email to the 
following address: support@megapixelvr.com. Please indicate which specific HELIOS OptiTune version you are 
using. Each Qt version will be available for three (3) years after the release date of the corresponding HELIOS 
OptiTune version.

OpenCV

HELIOS OptiTune uses OpenCV (Open Source Computer Vision Library), an open source computer vision and 
machine learning software library.

https://opencv.org/

Copyright (C) 2000-2022, Intel Corporation, all rights reserved.
Copyright (C) 2009-2011, Willow Garage Inc., all rights reserved.
Copyright (C) 2009-2016, NVIDIA Corporation, all rights reserved.
Copyright (C) 2010-2013, Advanced Micro Devices, Inc., all rights reserved.
Copyright (C) 2015-2023, OpenCV Foundation, all rights reserved.
Copyright (C) 2008-2016, Itseez Inc., all rights reserved.
Copyright (C) 2019-2023, Xperience AI, all rights reserved.
Copyright (C) 2019-2022, Shenzhen Institute of Artificial Intelligence and Robotics for Society, all rights reserved.
Copyright (C) 2022-2023, Southern University of Science And Technology, all rights reserved.
Third party copyrights are property of their respective owners.

Licensed under the Apache License, Version 2.0

http://www.apache.org/licenses/LICENSE-2.0

https://download.qt.io/archive/qt/6.3/6.3.0/
mailto:support@megapixelvr.com
https://opencv.org/
http://www.apache.org/licenses/LICENSE-2.0
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1 Introduction

1.1 Overview

HELIOS OptiTune is a tool to help configure a display controlled by the HELIOS Processor by generating a color 
calibration profile for the display overall and by balancing the individual LED Display Modules (LDMs) for 
consistent color.

There are two modes of operation:

1. Calibration mode - Generates a calibration profile for a display using one of the supported Colorimeters.

2. Balance mode - Per LDM RGB uniformity correction using one of the supported Sony mirrorless cameras.

1.2 Computer Requirements

OptiTune requires the following:

▪ MacOS 12.7 or later or Windows 10 21H2 / Windows 11 21H2 or later.

▪ One USB port for a Colorimetry Research Inc. colorimeter (calibration mode) or a Sony mirrorless camera 
(balance mode).

▪ Network connection to HELIOS (wireless requires an additional wireless router). 

1.3 Supported Colorimeters for Calibration

▪ Colorimetry Research CR-100/CR-120
▪ Colorimetry Research CR-250/CR-300

1.4 Supported Cameras for Balancing

A USB-connected Sony mirrorless camera is used for balancing.
▪ Sony A7C
▪ Sony A7Siii
▪ Dummy Camera (built in for offline testing)

1.4.1 Supported Lenses

Only the following lenses are supported:
▪ FE 4/24-70 
▪ FE 4/24-105 

NOTE: OptiTune can read a colorimeter’s measurements directly, and it has options for offline demonstrations 
and system testing. See sections 2.3.9 and 2.4.7 for more details on offline use.

https://www.colorimetryresearch.com
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2 Operation

2.1 Key modes

OptiTune has two key modes; Balance Mode or Calibration Mode. The current mode is shown in the main window 
title bar. 

Figure 1: Current mode

Use the Operation menu to switch between the two modes.

Figure 2: Mode Selection

2.2 Preparation

1. Launch OptiTune.

2. Enter the network address of the HELIOS, along with the username and password if the HELIOS has user 
authentication turned on (username and password are in the Preferences window).

3. Enter the other settings for calibration or balancing (some settings are in the Preferences window).

When OptiTune successfully connects to the HELIOS, any Output error status will disappear. The green/red status 
indicators for the camera and HELIOS display green when a device is OK, red on errors. If using Balance Mode, 
press the Refresh button to load the LDM configuration after the connection to the HELIOS has been made.

NOTE: For offline use, see section 2.3.9 Offline use. These features help with testing or learning OptiTune 
without requiring physical access to equipment.
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2.3 Calibration Mode

In calibration mode, OptiTune generates a calibration profile for a HELIOS display. It uses a USB-connected 
colorimeter or spectroradiometer to read the display output, while controlling the HELIOS over the network. Once 
a calibration has been generated, it is sent to the HELIOS as red, green, and blue color grading curves and an 
overall RGB gain adjustment. Calibrations can be saved to and loaded from disk.

Either a Colorimetry Research Inc. colorimeter or a spectroradiometer can be used for standard calibrations.  
Colorimeters are much faster at producing readings while spectroradiometers are more accurate. Calibrations 
with a colorimeter typically take about 20 minutes for a 17-point calibration. Relative calibrations can make use of 
the best each instrument has to offer. With Relative calibrations, the first point of calibration can be read with the 
more accurate spectroradiometer and subsequent points are read with a colorimeter. The following sections 
describe a Standard calibration with a spectroradiometer and a Relative calibration using both a 
spectroradiometer and a colorimeter.

2.3.1 Supported Colorimeters/Spectroradiometers

▪ Colorimetry Research CR-100/CR-120
▪ Colorimetry Research CR-250/CR-300

Figure 3: Calibration system topology

NOTE: For testing / demonstration purposes, the iPhone app Cine Meter II may be used as the colorimeter. 
However, it is not recommended for actual calibrations. The Cine Meter II connects via Wi-Fi, not USB. 
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2.3.2 Setup Standard Calibration

Set up the spectroradiometer ( CR250/300) facing the HELIOS display to be calibrated. Select a tile to measure. 
For best results, place the CR250/300 as close to the center of the selected tile as possible to eliminate ambient 
light spill and brightness falloff. Plug the CR250/300 into the USB port of the OptiTune computer. 

Launch OptiTune and ensure it’s in Calibration Mode.

Figure 4: Operation mode

OptiTune should find the CR250/300 automatically. If it doesn’t, a red status indicator appears in the Calibration 
Controls panel and Spectroradiometer not found is shown when hovering over the status indicator. Try unplugging 
the CR250/300 and plugging it back in.

In the main window, at the top Calibration Controls section choose the number of calibration points to use (17 is 
the default), and adjust the Point spacing if necessary.

Figure 5: Calibration Settings

NOTE: Spectroradiometers (CR250/300) need to be running firmware version 1.36 or later. 
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2.3.3 Run Standard Calibration

Press the Run button and calibration will start. Depending on the number of calibration steps and the CR250/300 
used, a calibration can take anywhere from a few minutes to several hours. During this time, do not change the 
light falling on the display, especially if the CR250/300 isn’t right up against the screen. Any ambient light changes, 
especially later in the calibration process, will result in color and brightness errors.

When the calibration completes, it is sent to the HELIOS as R,G,B color grading curves and Output Adjustment RGB 
values (see the Output page in the HELIOS web interface). 

If the calibration terminates before completion, press the Resume button to restart following the last good point.

Calibration files can be saved to disk as a tab-separated-value file.  Previously saved files can be re-loaded. When 
a file is loaded, it is immediately sent to HELIOS.
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2.3.4 Setup Relative Calibration 

Relative calibration is a dual instrument process. The first measurement point of the selected tile is made with a 
spectroradiometer (CR250/300). The subsequent points are made with a colorimeter (CR-100/CR-120).  Begin by 
setting up a CR250/300 facing the HELIOS display to be calibrated. Select a tile, and place the CR250/300 at the 
center of the tile, up to a meter away from the surface to allow more pixels to be in view. Ensure there is no ambient 
light spill on the tile. Plug the CR250/300 into the USB port of the OptiTune computer.

Launch OptiTune and ensure it’s in Calibration Mode.

Figure 6: Calibration mode

OptiTune should find the CR250/300 automatically. If it doesn’t, a red status indicator appears in the Calibration 
Controls panel and CRI Spectroradiometer not found is shown when hovering over the status indicator. Try 
unplugging the spectroradiometer and plugging it back in.

In the main window, at the top Calibration Controls section, enter one (1) Calibration points. The Relative checkbox 
should not be checked yet.

Figure 7: Calibration points and Relative settings

NOTES:  

• The spectroradiometer needs to be running firmware version 1.36 or later. 

• A spectroradiometer can be placed a little further away from a display than a colorimeter to capture more 
pixels. 
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2.3.5 Run Relative Calibration’s First Point

Press the Run button and calibration will start. Since only one (1) point is being measured calibration should take only 
a few minutes. During this time, do not change the light falling on the display, especially if the spectroradiometer 
isn’t right up against the screen. Any ambient light changes, especially later in the calibration process, will result in 
color and brightness errors.

When the calibration completes, it is sent to the HELIOS. See the Output pane in the HELIOS web UI for the results. 

If the calibration terminates before completion, press the Resume button to restart.

2.3.6 Setup the Relative Colorimeter Calibration

Disconnect the spectroradiometer and setup the colorimeter to measure the same tile the spectroradiometer was 
set to measure. For best results, place the colorimeter as close to the center of the selected tile as possible to 
eliminate ambient light spill and brightness falloff. Plug the colorimeter into the USB port of the OptiTune computer. 
Colorimeters must be running firmware version 1.36 or later.

In the main window, at the top Calibration Controls section, select the Filter and Matrix values for the colorimeter. 
OptiTune bases the target brightness for the correction on the brightness set in HELIOS. If the desired brightness is 
brighter than the camera can handle, an ND filter may be necessary. The matrix is a calibration matrix stored in 
the camera that is built based upon a spectroradiometer. Choose the number of calibration points to use (17 is the 
default), and select the Point spacing if necessary. Select the Relative checkbox. With the Relative checkbox 
selected, OptiTune will save the first point made with the spectroradiometer as the brightest point on the tonal 
scale and use it as a reference, adjusting all the other points relative to the first point.

Figure 8: Relative calibration colorimeter settings
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2.3.7 Run the Colorimeter Relative Calibration

Press the Run button and calibration will start.  A 17-point calibration with a colorimeter should take about 20 
minutes. During this time, do not change the light falling on the display, especially if the colorimeter isn’t right up 
against the screen. Any ambient light changes, especially later in the calibration process, will result in color and 
brightness errors. When the calibration completes, it is sent to the HELIOS.

2.3.8 Spot Measurement

With OptiTune in Calibration Mode, capture a measurement from the colorimeter by pressing the Spot Measure
button. The timestamped measurement can be copied from the Calibration & Measurement Data window as a text 
string.

2.3.9 Offline Use

In Calibration Mode, OptiTune can control a simulated HELIOS, and show a dummy display window emulating the 
output of the real or simulated HELIOS. An iPhone app, Cine Meter II, can be used in place of the CRI colorimeter. 
These features help with testing or learning OptiTune without without requiring physical access to equipment. The 
Alternate Devices and Debug Settings section of OptiTune Preferences window has checkboxes for enabling the 
Cine Meter II colorimeter and the HELIOS simulator. Enable the dummy display window with the menu Window > 
Show Dummy Display.

Figure 9: Alternate Devices and Debug Settings
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2.4 Balance Mode (BETA)

In Balance Mode, OptiTune matches the RGB levels of the display’s individual LDMs. One LDM’s output is used as a 
reference, and the others are adjusted to match it. OptiTune uses a USB-connected Sony mirrorless camera to 
measure the LDMs. Balancing corrections are made using each LDM’s RGB gains.

2.4.1 Supported cameras

A USB-connected Sony mirrorless camera is used for balancing.
▪ Sony A7C
▪ Sony A7Siii
▪ Dummy Camera (built in for offline testing)

2.4.2 Supported Lenses

Only the following lenses are supported:
▪ FE 4/24-70 
▪ FE 4/24-105 

2.4.3 Balancing Setup

Balancing requires a rectangular arrangement of display tiles with a solid border. The interior of the rectangle may 
be missing tiles, as long as the center of the display and the entire perimeter are populated. Tiles must be the same 
size and spaced consistently on a grid. OptiTune assumes that the display is an NxM array of uniform LDMs. If the 
wall or volume is larger than the camera can see in its entirety, use OptiTune’s Light LDM selection mode to 
illuminate one section of the display at a time. See the following section 2.4.4 Balancing Tips for more details.

Figure 10: Balancing system topology
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2.4.3 Balancing Setup (continued)

Launch OptiTune and ensure it’s in Balance Mode. OptiTune should find the camera automatically. If it does not, the 
status indicator in the Calibration Controls turns red and No camera detected is displayed when hovering over the 
status indicator. Try unplugging the camera and plugging it back in, then press the Connect button.

Figure 11: Balance Mode

Enter the IP address of the HELIOS. OptiTune’s HELIOS Controls panel shows a green status indicator when there’s 
communications with HELIOS, and a red status indicator on failure. Hover over the indicator to see status. Click the 
status indicator to add any error messages to the log.

Figure 12: Connect HELIOS

OptiTune does not automatically configure the HELIOS output image for balancing. Use the HELIOS user interface 
to display a color-neutral flat field test pattern (for example, Output > Image Settings > Show test pattern, and 
select a White or Gray pattern). The display brightness should not exceed 1000 nits, otherwise the camera may not 
be able to set its exposure properly.

Set up the camera facing the display. For an architectural display, put the camera as far back as possible and zoom 
in as needed. This will minimize off-axis color rendition errors. For virtual production, place the camera where the 
production camera is most likely to be. Ideally, off-axis rendition errors are balanced out from the camera’s 
viewpoint. See Chapter 6 on Balancing Camera Setup for details.

Zoom the lens to a marked focal length, or halfway between two marked focal lengths. In the OptiTune Balance 
Controls panel, select the Lens in use, and select the focal length: @24 for 24mm, @24~35 for the point halfway 
between 24 and 35mm, @35 for 35mm, etc. 

NOTE:  Some lens choices have [1200x800] appended. These options are for Megapixel testing and 
debugging. The lens selections function the same as their counterparts without the [1200x800] tag. The 
difference is that their compensation files are 1200x800 pixels, instead of 180x120 pixels.
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2.4.3 Balancing Setup (continued)

OptiTune reads the LDM configuration from the HELIOS and displays it in the LDMs panel. The LDM configuration 
can be reloaded (after setting a new HELIOS address, or if the LDM arrangement has changed while OptiTune is 
running) by pressing the Refresh button in HELIOS Controls.

Size the LDM display to fit the LDMs panel with Cmd+0 (Mac) or Ctrl+0 (Windows), zoom in with Cmd++/Ctrl++, 
and zoom out with Cmd+−/Ctrl+−. 

LDMs: radio buttons Light, Adjust, Target and Data select the behavior for when the LDMs display is clicked or 
dragged on. See section 2.4.6 on LDM Display Modes for more details.

Figure 13: Balancing settings

Select Target mode and click on an LDM to use as a reference value. The camera exposure is adjusted, the target 
LDM is sampled, and its RGB values are shown in the HELIOS Controls panel if they’re OK. Otherwise, OptiTune will 
recommend appropriate changes to the display’s brightness. 

When a suitable reference LDM has been obtained, press OptiTune’s Run button, and balancing will start.

2.4.4 Balancing Tips 

Errors when detecting a display. OptiTune will display one the following errors if it can not detect the four corners 
of a display or does not detect a display at all. 

TileGrader failed to detect rectangular display in captured image: contour has N points, not 4! 

TileGrader failed to detect display in captured image: no contour found!  

Open the Preview window to examine the image OptiTune is complaining about.  The contour OptiTune refers to is 
the green outline on the image. Ensure the camera placement and lens focus allow OptiTune to have a clear view of 
the entire display.
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2.4.4 Balancing Tips (Continued)

Use the Refresh button as needed to re-read the HELIOS LDM array. 

When using the HELIOS Simulator, press any of the [NxM] buttons to generate a new dummy LDM array with 
simulated LDM variations. 

When the HELIOS simulator and/or Debug options are enabled, a [↺ Var] button can be used to toggle between 
clean LDMs with no added errors and LDMs with random output variations are added. The variation is only added 
to the dummy display. The actual HELIOS display is unaffected. 

Right-clicking on the LDMs in the LDMs panel displays a menu with Light All LDMs, Adjust All Lit LDMs, and Reset 
All LDMs options. The Reset All LDMs option returns all LDMs to their default state. All LDMs are lit and set to their 
default R,G,B gains.

Only use version 24.02.0 or later for balancing. Earlier versions could misread the LDMs’ values.

Balancing adjusts LDMs in batches. Depending on the batch size, the total number of LDMs in the display, and the 
speed of the computer, a balance can take anywhere from a few minutes to an hour and a half. During this time, do 
not change the light falling on the display. As balancing proceeds, it is changing the individual LDM RGB gains as it 
goes. View these changes on the HELIOS’s web UI Adjustments pane, or in OptiTune with Show gains selected on 
the HELIOS Controls panel. Set the Balance batch size for the computer in Preferences. 

If the balance terminates before completion, restart or resume it, as otherwise some LDMs may have been 
balanced, some may have been unchanged, and others will likely have been set to horribly wrong colors.

Pale red LDMs - LDMs that can’t be set bright enough are colored pale red. Pale red LDMs likely indicate an 
attempt to balance at too bright a level. This may happen if balancing to a target LDM in the center of the display 
and there is (from the camera’s viewpoint) a lot of falloff towards the corners of the display. Try picking a target 
LDM halfway between the center and edge of the display instead.

Blue LDMs - LDMs that can’t be darkened enough are turned blue. 

Gray LDMS - LDMs that cannot have their color gains determined are set to gray. Gray LDMs and/or log messages 
of “FAILED GETTING RGB DELTA VALUES” may be LDMs failing to respond to gain adjustments. However, if more 
than one is seen, it’s more likely to be a camera failure. Try reconnecting the camera, verify that it grabs an image, 
and then retry balancing. See chapter 6 on Balancing Camera Setup for more details.
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2.4.5 LDM Show Modes

Use the Show radio buttons in the HELIOS Controls panel to:

Image - Show the LDMs as captured images with their measured values inset. In the example below, the captured 
image shows aliasing aberrations, while the inset square for each LDM shows OptiTune’s measured value for that 
LDM.

Figure 14: Show: Image LDMs with false color values inset

Gains - show LDMS as a false-color rendering of their RGB gains.

Errors - show LDMs as a false-color rendering of their RGB errors (imbalances compared to the reference value).



HELIOS OptiTune - User Guide 17

2.4.6 LDM Display Modes

Light mode - click and drag to select the LDMs to illuminate; all others will be turned off. Do this in situations where 
the entire display is too tall or wide to be seen by the balancing camera all at once, or where the camera has been 
setup to see only a part of the display. The camera needs to see the illuminated LDMs with a dark border around 
them. 

Adjust mode - selects which lit LDMs will be balanced. By default, all lit LDMs are adjusted, but at times it is useful 
to adjust only a few. For example, to re-run balancing only on LDMs that (for whatever reason) didn’t balance 
properly on a previous run. Press Shift + drag to add to the current selection, or Alt/Option to subtract from the 
current selection.

Target mode -  click on an illuminated LDM to use it as the balancing reference. The LDM’s RGB values will be 
shown above the display in the HELIOS Controls panel, and remembered across sessions. This is helpful when 
balancing a large display section-by-section. Grab an initial target value in the first illuminated section and run the 
balance; reposition the camera, illuminate a new section, and run a new balance using the previously set reference 
values so that the new section will match the previous one. Repeat until the entire display is balanced.

Data mode - displays the selected LDM’s observed RGB  values, and shows the errors between the actual and 
target RGB values. It also sets that LDM to display log messages.

2.4.7 Offline Use

In Balance Mode, OptiTune can use a dummy camera to simulate what a real camera would do. The program 
simply reads back dummy LDM values directly. Use either a HELIOS for output (its LDM configuration will be read 
and its gains will be set, but its observed LDM values will be simulated), or the built-in HELIOS Simulator (which can 
be set up in a variety of configurations). Whether using the dummy display directly or the HELIOS for output, the 
balance progress can be viewed on the dummy display. A real camera can be connected to read the dummy 
display as if it were a HELIOS’s output. 

The [↺ Var] button (arrow below) in the HELIOS Control panel toggles a random variation in the dummy display’s 
LDMs,  making them visually distinguishable from each other and adding a built-in “error” to balance out. 

Figure 15: Var button
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3 User Interface

All controls in OptiTune are live, changes are applied immediately. To finish editing a text control’s value and apply 
it, press Return or Enter, or exit the control by pressing Tab or selecting a different control. Starting or resuming a 
calibration, balance, or spot measurement will also finish editing any active text control. 

3.1 Main Window

OptiTune’s main window consists of several labeled panels, not all of which are visible in every mode, and two of 
which may be shown or hidden. Some panels have a status indicator. If status is green the panel’s hardware device 
is properly connected and functioning, or red if an error is detected. Hover the mouse pointer over the indicator to 
see an error message. If an error is shown, click the status indicator to record that error in the log.

Calibration Controls - (Calibration Mode only) displays the colorimeter in use and its current readings for CCT, Duv 
(green/magenta tint), and luminance, and most important calibration controls:

Filter -  this value must match the physical ND filter installed on the spectroradiometer or colorimeter, otherwise 
the luminance readings will be (wildly) incorrect. Only one ND filter may be used at a time. Filter stacking is not 
supported in OptiTune. Each ND filter has a number printed on its collar, like 0.6. Select the same filter number in 
OptiTune, such as “ND-120-0.6”.

Matrix -  is used with colorimeters. The matrix selected is used to match the response of the colorimeter with that 
of a spectroradiometer measuring the same source. These matrices are created by aiming both devices at the 
source tile. Then, using the CRI software to create a correction matrix. This matrix is then loaded into the 
colorimeter and made available on demand. In OptiTune select the matrix created with the current LED display 
technology in use. As an example, Ventana XR12 tiles need a Ventana XR12 matrix. This helps the CR-120 match 
the CR-300’s readings more closely. The matrix name in OptiTune depends on how the matrix was named when it 
was created in the CRI software.

Calibration points - the number of calibration points to be measured.

Relative - check this box to measure points relative to the brightest point, assuming the brightest point has already 
been set correctly.

Point spacing - cluster points to favor the shadows, or space them evenly across the tonal scale. See 3.3.1 
Calibration Settings for details.

Spot Measure - captures a colorimeter reading and displays it in the Calibration & Measurement Data panel.

NOTE:  A text control with an invalid entry will show the text and cursor in red. This can be a number field with 
an out-of-range number or no number at all. Invalid entries will revert to the previous value when finished 
with editing. For example, if Calibration Points are changed from 17 to 0, 0 will be displayed in red, and 
OptiTune will revert to 17 when the Return, Enter, or Tab keys are pressed, or the Run button is selected.
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3.1 Main Window (continued)

Balance Controls -  (Balance Mode only) shows the camera name, its ready and busy status, and buttons to 
(re)connect it and test image grabbing. Two Lens drop down menus allow for compensation to the shading or 
vignetting of the lens. Select the lens for the camera in the first  and the current focal length (@24 for 24mm; 
@24~35 for midway between 24 and 35mm, etc.) in the second.

HELIOS Controls - shows HELIOS or Simulated HELIOS depending on what OptiTune is connected to. In the case 
of a real HELIOS, the IP address will also be shown. In Calibration Mode current R,G,B values are shown. In 
Balance Mode, the panel shows the target RGB values for balancing. The Image radio button displays LDMs as a 
camera-captured false-color image with the measured values of the LDMs superimposed onto the original image 
to highlight changes. Gains are similar to the HELIOS UI’s Adjustments display in that they show any additional 
gain being applied to the LDM. Errors display LDM deviations from the target RGB values. Both gains and errors 
use exaggerated false-color renderings to highlight any changes.

Radio buttons - The radio buttons described below select what happens when clicking and dragging on LDMs in 
the LDMs panel:

Light -  to illuminate the selected LDMs. A single rectangular selection is allowed.

Adjust - to adjust only the selected LDMs. Multiple selections can be made in Adjust mode: hold down Shift           
while dragging to add LDMs, Option/Alt while dragging to remove LDMs.

Target - click on an LDM to use its RGB values as the balance target value.

Data - click on an LDM to display its Data in the Log Messages and the status line.

Calibration & Measurement Data - (Calibration Mode only) shows calibration results and Spot Measurements. Text 
can be selected and copied out of this panel. 

LDMs  - (Balance Mode only) shows the LDM array. Size the LDMs to fit the panel with Cmd+0 (Mac) or Ctrl+0 
(Windows), zoom in with Cmd++/Ctrl++, and zoom out with Cmd+−/Ctrl+−. Use the radio buttons in the HELIOS 
Controls panel to show the LDMs as measured values atop the camera-captured image, as gains (similar to the 
Adjustments page in the HELIOS web UI), or as errors relative to the reference value. 

Right-click to display a menu:

Light All LDMs - illuminates all LDMs, without resetting their RGB values.

Adjust All Lit LDMs -  sets all lit LDMs to be adjusted.

Reset All LDMs -  illuminates all LDMs and resets their RGB values to defaults.

Output Controls - has R,G,B sliders for direct manipulation of the output (Calibration Mode only). This panel can be 
shown or hidden using the View menu.

Log Messages -  are shown below Calibration & Measurement Data or LDMs. This panel can be shown or hidden 
using the View menu, resize it by clicking and dragging on its top border. Use the usual copy command to select 
and copy text out of this panel.

Status bar - at the bottom of the window shows status messages, and displays a green progress bar during 
calibrations and tests.

Run/Stop and Resume buttons at the lower right corner provide controls to run and stop calibration and balancing. 
Resume restarts a calibration or balance interrupted before completion, picking up where the previous run 
stopped.



HELIOS OptiTune - User Guide 20

3.2 Menu Items

Most menu items are self-explanatory, but a few are worth describing in detail.

File > Open Calibration… read a calibration file from disk and send it to HELIOS (if HELIOS is the current output). 
Calibration files are tab-separated-value files with .tsv or .txt extensions. These are normally saved by OptiTune 
but may be edited externally. See Calibration Files for more details.

File > Save Calibration… save a calibration to a tab-separated-value file on disk. See Calibration Files for more 
details.

File > Save Log… saves the log text to a file on disk. When reporting a bug, please include the log file with the bug 
report.

Operation > Calibration Mode puts OptiTune into Calibration Mode, for use with a colorimeter to calibrate the 
color and tonal scale of a display.

Operation > Balance Mode (BETA) puts OptiTune into Balance Mode, for use with  a connected camera to balance 
all the LDMs in a display to a common color and brightness.

Operation > Run, Resume, Stop, and Spot Measure replicate onscreen buttons and provide their keyboard 
shortcuts.

Operation > Check for Update checks for a newer version of OptiTune on Megapixel’s server. If an update is found, 
it can be downloaded and installed or simply ignored.  If the update is ignored, OptiTune will reminded about it on 
the next startup or manual check. If ‘skip this version on startup checks’ is selected, it will still be visible during 
manual checks.

Operation > Debug Options toggles the visibility and applicability of various menu and preference items used in 
debugging. This setting is off whenever the program is started; its state does not persist across runs.

Operation > Read-Count Test (debug option) runs a series of read count tests. Fifty (50) repetitions each of 
measurements created by averaging 1, 2, 4, 8, 16, 32, and 64 separate colorimeter readings. This is a 
development/debugging tool and not something normally used. Read-Count Test is run to determine the best 
Readings per measurement value in Preferences. Combine enough readings to minimize error, but not more than 
necessary as taking more readings takes more time.

Operation > Auto-Restart after 15 sec. (debug option) toggles automatic restarting of calibration or balancing 
after the previous run completes. This is a debugging function; in normal use leave this unchecked. Auto-Restart 
only applies when Debug Options are enabled.

Operation > Profile TileGrader (debug option) enables log-panel output of the time taken in milliseconds for 
various parts of the balance-mode image processing pipeline. This is a debugging function. In normal use leave 
this unchecked.

Window > Show Dummy Display shows a “dummy window” emulating a HELIOS display. It shows a solid color in 
calibration mode, or an array of emulated LDMs in balance mode. Use the dummy display in place of a HELIOS’s 
actual output for testing and training. In balance mode, use the [↺ Var] toolbar button to toggle the dummy 
display’s LDMs between “clean” versions with no added variation and versions with random added variations. 

Window > Show Camera Preview (Balance Mode only) opens a window showing the camera-captured image with 
a green outline around the illuminated LDMs. The green outline should show a rectangle (in perspective) with four 
corners; if the edges show jagged lines, a corner gets clipped off by too-tight framing, or other visual errors occur 
that “break” that four-cornered polygon, OptiTune won’t be able to detect the LDMs’ locations and balancing will 
fail.

Window > Reset Windows is useful if any of the windows fail to appear, or get stuck behind the Mac menu bar or 
the Windows taskbar. It resets the windows to their default sizes and positions in the middle of the screen.
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3.3 Preferences

The Preferences window (Windows: Alt+E, E; MacOS: Command+,) configures all of OptiTune’s connections and 
calibration settings. It is divided into five (5) sections; Calibration Settings, Balance Settings, HELIOS settings, 
Operational Settings, and Alternate Devices and Debug Settings.

All controls are live. Any changes made apply immediately. To apply a text control’s value, press Return or Enter, 
exit the control, or close the window. 

Reset parameters to their defaults with the Reset to Defaults button. Doing so will not erase network addresses, 
usernames, passwords, or colorimeter filter and matrix settings.

Valid text control values are displayed in normal text. Invalid values are shown in red. Most text fields won’t allow 
more characters than a valid value would have. When invalid values are detected, exiting the text field or closing 
Preferences will revert to the field’s previous contents.

Figure 16: OptiTune Preferences

3.3.1 Calibration Settings

Filter - sets the colorimeter filter used. It should match the physical filter fitted to the colorimeter. OptiTune uses 
this setting to ensure that luminance readings are correctly displayed. If this is not set correctly, OptiTune will still 
run, but the luminance values shown and the calibration will be wrong.

Matrix - sets the colorimeter’s calibration matrix. When using a CR-100 series colorimeter, set this to the matrix 
that matches the CR-100 to the CR-300 or other spectroradiometer for the LDMs in use.

Calibration points - determines how many calibration levels are measured, from light to dark. More points give a 
finer-grained calibration, but take longer to measure. As few as 1 point can be run, or as many as 99 points. 
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3.3.1 Calibration Settings (Continued)

Relative - when enabled, OptiTune assumes the brightest point on the tonal scale has already been set to the 
correct color and brightness using a separate calibrator, and all other points are adjusted relative to that point. 
When relative is disabled (normal calibration), all points on the tonal scale are adjusted for the proper color and 
brightness. The brightest step on the tonal scale is measured and used as the reference level and white balance for 
the rest of the steps. Use relative calibration when HELIOS’s brightest point has already been calibrated for 
brightness and color using a separate tool, such as Portrait Display’s Calman with a spectroradiometer. This is 
handy way to optimize both accuracy and speed. Although it’s slow to use, a spectroradiometer can get very 
accurate results. Use it for the brightest point and then use OptiTune with a colorimeter to rapidly calibrate the 
rest of the tonal scale based on that brightest point.

Measure ambient black - OptiTune assumes an initial zero ambient light environment by default. Enabling this 
setting has OptiTune spend time measuring the ambient light level. Useful for when the results consistently have 
crushed shadows, or calibration halts prematurely with can't set R,G,B any lower errors. Measuring black level 
takes longer, and may fail with timeout errors if the display is truly black. Only measure black level if calibrations 
without measurement result in crushed shadows or halt prematurely with can't set R,G,B any lower errors.

Point spacing - defines the distribution of measured points. By default OptiTune will favor shadows, measuring 
more points near the low end. This setting ranges from strongly favoring shadows, to evenly distributing points 
across the tonal scale. With the slider all the way to the right (1.0), the points are evenly spaced from px = 0.0 to px 
= 1.0, Moving the slider leftwards applies a power function to the spacing, bunching the points leftwards towards 
the shadow end of the calibration curve, at the expense of the highlights. Pushing the points leftwards provides 
more control of the calibration in the lower levels, roughly approximating the distribution of stops of exposure 
across the tonal scale. The default Point spacing is in the middle of the slider, 2.0.

Figure 17: Point spacing

Readings per measurement  - the number of individual readings taken and averaged together for a single 
measurement. Color reading are notoriously noisy and averaging multiple readings improves precision 
considerably. 4 is the default value for CR-100 series colorimeters (OptiTune will automatically use a single reading 
when a spectroradiometer is used, since spectroradiometer readings are (a) more precise to begin with and (b) 
take too long for large Readings per measurement values to be practical). The valid range is 1 to 99.

Allowable RGB error, % - sets the strictness of the calibration, trades off speed vs accuracy. A large error, like 1%, 
will run quickly, but with less accuracy; 0.1%  or less will essentially run until it has 15 measurements within 1%, and 
averages them. Intermediate values of 0.3% or 0.5% are a good starting point. Normally OptiTune will try for 
output errors of 0.3% or less by default, but a larger error can be allowed for faster calibration at the cost of 
accuracy, or a smaller error for higher accuracy at the cost of a longer run time. A value of 0% will run until 15 
closely-spaced measurements are detected or until 50 readings are made, and the final value is a weighted 
average of closely-spaced readings.

Point spacing 3.0 Point spacing 2.0 Point spacing 1.0



HELIOS OptiTune - User Guide 23

3.3.2 Balance Settings

Balance batch size - determines how many LDMs will be balanced in parallel. Higher numbers balance more LDMs 
at a  time, but may slow the computer. Batches are run until all LDMs are balanced, so the larger the batch size, 
the fewer steps are needed to balance an entire display. However, Windows machines struggle when batch size is 
too large. OptiTune will slow down. Timeouts, poor UI responsiveness, and hangs may occur. On Windows, a low-
power Celeron N5105 works well with batches of 200–300, while a Core i5 1235U can handle 300–500 at a time. 
On Mac, any recent machine, whether Intel or Apple Silicon, will run well with batches of 1200 or more.

3.3.3 HELIOS Settings

HELIOS address is the network address of the HELIOS, for example 192.168.0.45 or helios.local. (No http:// prefix is 
required.) Username and password are required if the HELIOS’s user authentication is turned on. When these are 
incorrect, the HELIOS panel shows a red status indicator, and the error Incorrect username or password appears 
when the mouse is hovered over the indicator. After entering the correct values, press Enter or Return, and the 
status indicator should turn green. HELIOS settings have no effect when using the HELIOS simulator.

3.3.4 Operational Settings

Measurement delay, msec - determines how long OptiTune waits between sending a command to HELIOS and 
taking a measurement. This delay allows HELIOS to process the message, and time for the colorimeter to adjust to 
the new brightness level.  This can be set as low as 100 or as high as 3000. Measurement delay applies to both 
calibrations and balances.

3.3.5 Alternate Devices and Debug Settings

Controls for non-standard input and output devices for testing and training purposes.

Cine Meter II colorimeter- uses the Cine Meter II iPhone app in place of a CRI colorimeter for calibrations.

Dummy camera -  runs balances with no camera connected. LDM values are “observed” by reading back internal 
values from the LDM dummy display’s Data structures (whether or not the dummy display is shown).

HELIOS simulator - uses an internal simulated HELIOS instead of a real HELIOS.

Simulator’s target CCT -  is the calibration color temperature target, in Kelvins. Enter a value from 1667 to 
10000.

Simulator’s target duv - is the calibration duv (green/magenta tint) target. This is normally set to 0; valid values 
are -0.0100 to 0.0100.

Simulator’s target gamma (HDR) - is the gamma (HDR) value target.  The default value is 1.0. Valid settings are 
from 0.46 to 1.6, but only when Gamma override is set to “Straight” (Debug option).

Simulator’s brightness, nits -  tells the HELIOS Simulator how bright white is supposed to be. It corresponds to 
the Output > Image Settings > Brightness control in HELIOS, and can run from 1 to whatever the maximum 
brightness of the HELIOS is (normally 1000 nits). OptiTune uses Calibration Brightness as its target brightness 
value.

Cine Meter II address  - is the network address of an iPhone running Cine Meter II, for example 192.168.0.46 or 
Freds-iPhone.local. No http:// prefix is required. This address is only needed if the colorimeter input is set to 
Cine Meter II.
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Gamma override -  Enable with the Operation  > Debug Options. Has two settings:

sRGB - calibrates to sRGB, a modified 2.4 (SDR) gamma with a linear segment in the shadows. Compared to 
“Straight”, this will brighten mid-tones slightly. HELIOS must be set to Gamma (HDR) 1.0 to use sRGB 
calibration. This is the default gamma if the HELIOS doesn’t specify an eotf type, and for the simulated 
HELIOS.

“Straight” - gamma reads HELIOS’s gamma value and calibrates to it directly. 

Figure 18: Debug Options enabled

NOTE: sRGB gamma is always assumed when this setting is not visible, unless the HELIOS’s eotfType is 
sdrPower. If HELIOS specifies sdrPreserve, sRGB is used. If HELIOS specifies an eotfType other than sdrPower 
or sdrPreserve, a warning is displayed in the log and sdrPower is used.



HELIOS OptiTune - User Guide 25

4 Tips & Troubleshooting

Virus warnings on Windows: Sometimes Windows prevents installing OptiTune “because the file contains a virus or 
potentially unwanted software.” It may be a false positive. Microsoft Defender has found nonexistent viruses in 
OptiTune installers before. To be on the safe side, validate the installer using a separate antivirus program like 
Malwarebytes or ESET Online Scanner. If no viruses are found, turn off  Real-time protection in Windows Security > 
Virus & threat protection settings, install OptiTune, then turn Real-time protection back on.

System Errors on Windows: if a series of alerts about dlls not being found are seen when starting OptiTune, install 
or repair the Visual C++ runtime. Open the installation folder (typically Local Disk > Program Files (x86) > HELIOS 
OptiTune) and find the vc_redist.x64.exe or vc_redist.x86.exe installer. Run it to install or repair the needed 
runtime files. Once it completes, OptiTune should start without problems.

Ambient light is a killer: ambient light spilling on the display during lower-level calibration steps causes errors in 
both color and brightness. For best results, place the colorimeter up against the display, or leave the room 
completely dark while calibration is in process.

Don’t run two instances of OptiTune at the same time: OptiTune’s periodic polling of HELIOS when idle can cause 
calibration conniptions on the active copy, as the “curves enabled” switch in HELIOS gets randomly reset when two 
OptiTunes are running.

Network errors: If OptiTune can’t find HELIOS or Cine Meter II, make sure the correct network address has been 
entered. Also ensure that all communicating devices are on the same subnet. If connection errors persist, restart 
OptiTune.

CRI colorimeter not found: the CRI colorimeter should be detected automatically when it’s plugged in. If it isn’t, try 
a different USB port on the OptiTune computer. If plugging into a hub, try plugging into the computer directly.

Camera connections: for best results, connect a camera directly to the OptiTune computer. Using a USB hub, 
especially one with other active connections, greatly increases the chance of camera connection errors and failed 
balances. If the connection fails, try turning the camera off, on, and pressing Connect again. It takes about ten 
seconds for a camera to be detected and connected. Mac laptops using Apple Silicon may need USB accessories 
to be allowed: https://support.apple.com/en-us/102282.

No camera detected (on Windows): if an old version of OptiTune was uninstalled after installing the new version, 
OptiTune’s camera-specific drivers were uninstalled, too. Reinstall the current version to fix this.

Camera Error 0x8208 (on Mac): If this error is seen in the log window immediately after a camera is detected, turn 
off the camera and the Mac and try again after a minute or two. If that does not fix the problem, try resetting the 
SMC (for Apple Silicon: power off, unplug power and USB, wait a minute, plug in and start up. For Intel: see https://
support.apple.com/en-us/102605). If the error still occurs after several attempts, try resetting the camera (Menu > 
Setup > Setting Reset > Camera Settings Reset) or Initialize the camera if Camera Settings Reset doesn’t fix the 
problem).

Failures / hangs in background operations: OptiTune can fail when run on memory-constrained machines when it’s 
not the frontmost, active application. If Memory Pressure is in the yellow zone (Mac) or usage north of 75% with 
active swapping (Windows), either leave OptiTune running in the foreground or shut down other programs and 
unneeded browser tabs that soak up system memory.

Balances go “plaid”:  If the display starts turning plaid, or showing alternating columns of light and dark LDMs, 
make sure you have updated to OptiTune version 24.02.0 or later. Earlier versions could misread the LDMs’ values.

https://support.apple.com/en-us/102282
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4 Tips & Troubleshooting (Continued) 

Verify results in HELIOS: When a calibration completes, open the HELIOS web UI and look at the RGB curves on 
the Output page: those curves are OptiTune’s calibration.

Colorimeter limits: CRI colorimeters will not measure in very dark conditions. OptiTune assumes a luminance of 
zero nits when this occurs, and calibration will stop at that point (brighter calibration points will still be sent to 
HELIOS). Cine Meter II is set to report 0 nits at light levels below 0.05 nits. Cine Meter II cannot measure CCT below 
1667 K, so calibrations close to that color temperature will fail or be inaccurate. Set a Target CCT of 1750 or higher 
when using Cine Meter II. 

Window not shown / not draggable? If the OptiTune window or Dummy window is partially or fully offscreen, press 
Shift+Ctrl+Alt+W (Windows) or Option+Shift+Command+W (Mac) to recenter them.

HELIOS status not updating? HELIOS status is not checked while taking a measurement or performing Read Count 
tests. HELIOS LDM status is not checked while in balance mode; press Refresh to reload LDM configuration and 
gains.

Buttons and controls flicker when a calibration is stopped: When Esc or Stop is pressed, OptiTune briefly returns to 
a running state. OptiTune sends the calibration to HELIOS after it is stopped, but it needs to be in running mode to 
do so. 

Using the Dummy Display: The Dummy Display can be driven into clipping if the Calibration Brightness is higher 
than the Dummy Display can handle; if this happens, calibration will fail. Look at the text along the bottom of the 
Dummy Display window; the first chunk is something like “#aabbcc”. If aa, bb, or cc is “ff”, then clipping is 
occurring; lower the calibration brightness and try again.

Setting Allowable RGB error: in an ideal world, OptiTune would always deliver a perfect calibration with zero error, 
but that usually isn’t possible. How to tell? Look at the Averages line in the log panel after a calibration run with an 
allowable error of 0%:

Averages over 48 points: 50 iterations, 169 seconds, errors 121 K CCT, 0.0007 duv, 2.57% luminance

If iterations is close to or equal to 50, OptiTune wasn’t able to converge on a solution. It simply gave up after 50 
tries, and picked the best value out of those 50 attempts. Setting Allowable RGB error to a nonzero amount lets 
OptiTune quit when the RGB values are “close enough”, without getting all the way down to zero error. Calibrations 
run much faster when close enough is good enough. If there is little downtime between shows, that may mean the 
difference between being able to run a calibration and not being able to due to time limits.

Even tiny allowable errors — a fraction of a percent — let HELIOS calibrations run much faster without a 
noticeable effect on the results. Again, the Averages line in the log panel shows how long it took to compute a 
typical point (in iterations and seconds) as well as the average errors in CCT, duv, and brightness. 

Run a few calibrations to compare various allowable error settings (use a limited number of steps, such as 5 or 10). 
The sweet spot will be where the best results are obtained in the least amount of time.
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5 Calibration Files

OptiTune can save and reload calibration files in tab-separated-value (TSV) format. These files contain multiple 
fields for each calibration point, only half of which HELIOS actually cares about: Px, Py, Mx, and My values, and 
DisplayGain values. 

Field(s) Value(s)

red

green

blue

R,G,B values for the calibration point. These are large integer values in versions before 0.7.15, floats from 0.0 
to 1.0 (same as Py values) in 0.7.15 and later.

cct
duv

luminance

Measured color temperature, tint, and brightness values for the point. In relative calibrations, these are 
“adjusted” values based on the color and brightness of the brightest point, not the actual values returned by 
the colorimeter. CCT and duv are the actual values plus the difference between actual and nominal values of 
the brightest point, while luminance is the actual luminance scaled so the brightest value matches the nominal 
value of the brightest point.

luminanceTarget Target brightness for the point, calculated from the maximum and minimum measured brightnesses and the 
desired gamma value.

redPx

redPy
Red-channel x,y coordinates for the point on a 0.0–1.0 scale: x values are spaced depending on the number 
of calibration steps and the step spacing control; y values are brightnesses.

redSlope The slope: (Mx-Px)/(My-Py).

greenPx

greenPy
Green-channel x,y coordinates for the point on a 0.0–1.0 scale: x values are spaced depending on the 
number of calibration steps and the step spacing control; y values are brightnesses.

greenMx

greenMy
X,Y coordinates of “handles” for the Px,Py values: these determine the slope of the curve through Px,Py

greenSlope The slope: (Mx-Px)/(My-Py).

bluePx

bluePy
Blue-channel x,y coordinates for the point on a 0.0–1.0 scale: x values are spaced depending on the number 
of calibration steps and the step spacing control; y values are brightnesses.

blueMx

blueMy
X,Y coordinates of “handles” for the Px,Py values: these determine the slope of the curve through Px,Py.

blueSlope The slope: (Mx-Px)/(My-Py).

redDisplayGain

greenDisplayGain

blueDisplayGain

Floating-point “Output Adjustment” gains (as shown in the HELIOS web UI), a.k.a dev.display.gains values (as 
shown in the API), used for the initial, brightest, calibration point.

seconds The time in seconds it took to get this calibration point. The sum of these values is how long the entire 
calibration took.
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5 Calibration Files (continued)

Calibration files saved with older (pre-0.4) versions of OptiTune lack the DisplayGains fields; values of 1.0 will be 
used when those files are loaded.

Hand-editing these files to change values is not recommended, with one exception as discussed below. Many of 
these fields are derived from other fields, so editing them can lead to internal inconsistencies. Some are 
informational only, so editing them only invalidates their documentary purpose. For example, editing red, green, 
blue, cct, duv, and luminance changes how the calibration is displayed in OptiTune, but has no effect on HELIOS. 
HELIOS only cares about the Px,Py, Mx,My, and DisplayGains fields. Editing slopes and seconds has no effect on 
OptiTune or HELIOS. These are convenience values for troubleshooting only.

There is one circumstance in which editing the files can be useful. On occasion one calibration point, or a small 
cluster of points, may be seriously incorrect. For example, when a PA briefly switches on the lights in a darkened 
studio in the middle of a calibration. Those points can be deleted from the file, and HELIOS will interpolate the 
curves through the gap.

If points are deleted from a file, be sure to delete not only the offending points, but the point just above and the 
point just below as well. For example, if points 38, 39, and 40 are bad, delete points 37 through 41. The 
immediately adjacent points need to be deleted because Mx,My values are calculated based on their Px,Py values 
plus the Px,Py values of their immediate neighbors. The slopes of points just above and below an erroneous group 
are polluted by the bad points in the group itself.

Loading an edited file in OptiTune immediately sends it to HELIOS (if OptiTune is connected to HELIOS at the time). 
Open the HELIOS web UI and view the result in the Output pane. See the HELIOS user guide’s section on color 
grading tools for more details. Fine tune the slopes of the curves around the gap using the handles provided in the 
UI.
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6 Balancing Camera Setup

By default or when the camera has been reset, Lens Compensations are all Auto, Picture Profile is Off, and PC 
Remote uses USB. To get started, set PC Remote On and plug it in with no other setup required. Setup the Sony 
mirrorless camera as follows.

6.1 Menus on the A7C

Required:

Menu > Network > PC Remote Function > PC Remote > On
Menu > Network > PC Remote Function > PC Remote Cnct Method > USB
Menu > Camera Settings 1 > Lens Compensation > (all settings to Auto)
Menu > Camera Settings 1 > Picture Profile > Off

Recommended:

Menu > Camera Settings 1 > Aspect Ratio > (whatever best matches the aspect ratio of the display being 
measured; 16:9 in most cases. This can only be set when the file format is not set to Raw.)

Menu > Camera Settings 2 > Silent Shooting > On

6.2 Menus on the A7Siii

Required:

Menu > Network > Transfer/Remote > PC Remote Function > PC Remote > On
Menu > Network > Transfer/Remote > PC Remote Function > PC Remote Cnct Method > USB
Menu > Shooting > Image Quality > Lens Compensation > (all settings to Auto) 
Menu > Exposure/Color > Color/Tone > Picture Profile > Off

Recommended:

Menu > Shooting > Image Quality > Aspect Ratio > (whatever best matches the aspect ratio of the display being 
measured; 16:9 in most cases. This can only be set when the file format is not set to Raw.)
Menu > Shooting > Shutter/Silent > Shutter Type > Electronic Shutter
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6.3 Camera Setup Steps

1. Connect the camera to the OptiTune computer with a USB cable. For best reliability, do not use a USB hub 
between camera and computer. 

OptiTune will try to connect to a camera when it starts up, but it won’t retry automatically if a camera isn’t 
detected. If the camera panel in OptiTune doesn’t show the camera’s name, press the Connect button to retry. 
Once a camera has been found, OptiTune will usually reconnect automatically should the USB cable get yanked 
and reinserted, or the camera get turned off and on. However, the Connect button can always be used to reset 
things and start over.

If OptiTune gets stuck with a camera error saying Setting program mode to M… try turning the camera’s Mode 
dial to M. If any other “Setting <parameter>...” error is seen for a long time (more than a couple of seconds), 
try turning any of the camera’s control wheels a click or two, power-cycling the camera, or pressing the 
Connect button to re-establish the connection.

Figure 19: Connect button

2. Position the camera and zoom the lens to capture the entire HELIOS display. The camera needs to see all four 
corners cleanly, without cropping. Set zoom to one of the marked focal lengths, or halfway between marked 
focal lengths. Use the Lens drop down menus in OptiTune’s camera panel to select the lens and the focal 
length. These settings compensate for the shading or vignetting of the lens, to ensure even brightness and 
color across the display when balancing. Marked focal lengths are shown as @24mm, @35mm, etc. Halfway-
between focal lengths are shown as @24~35mm, @35~50mm, etc.

Some focal lengths may be labeled with additional info, for example “@35mm [1200x800]”. The bracketed 
information indicates an alternate version. The bracketed “1200x800” marks a compensation file rendered at 
1200x800 pixels instead of the default 180x120 pixels. Use either the “@35mm” or the “@35mm [1200x800]” 
compensations, both should give comparable results. The 1200x800 version is supplied as a debugging tool. 
Balance with the default compensation and the 1200x800 compensation to see if there is a noticeable 
difference between the two choices.

Manually focus the camera, and look for moiré in the image (use the camera’s MF Assist or Auto Magnifier 
settings to magnify the view and see more detail, or Grab an image and look at it in OptiTune’s Preview 
window). If moiré is seen, defocus just until the moiré disappears.
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6.3 Camera Setup Steps (Continued)

3. Grab an image. The Grab button tells the camera to capture an image and transfer it to the computer. 
Messages in the log panel (View > Show Log panel) report the results. The captured image with the detected 
screen outline is shown in the Preview window. The extracted screen image is shown behind LDM outlines when 
Show: Image is selected. If the camera will not grab an image, try turning it off and on again, or pressing the 
Connect button to re-initialize it.

Figure 20: Grab button and Log Messages

4. Display a test pattern on HELIOS, then set aperture (F number) to f/8 if possible, or smaller if necessary (if the 
ISO can’t be set low enough for a proper exposure at f/8). HELIOS Test patterns should be 1000 nits or lower in 
brightness, otherwise the camera may not be able to properly expose for it. Click on a reference LDM in target 
mode to have OptiTune adjust the camera’s exposure to the proper level. If OptiTune is unable to, either adjust 
the camera manually or change the display brightness on the HELIOS. Configurations can be saved, 
downloaded, and uploaded to the HELIOS using the Settings > Saved Configurations tab in the HELIOS web UI.

5. Confirm the display outline. The Preview window shows the detected outline of the display as a green line. It 
should be a rectangle in perspective, showing four corners. If the green outline (contour) shows more than four 
corners or shows jagged edges darting into the screen area, make sure the entire display is in frame and that 
the camera has been defocused enough to eliminate any moiré that’s confusing the edge detection.

NOTE: When a target LDM is properly exposed, the LDM’s RGB values will be captured as well as the camera’s 
shutter, aperture, and ISO. When a target LDM is selected, these shutter, aperture, and ISO values are used 
during the  balancing process. If any of these are changed while a balance is running, they will automatically 
be reset to the saved values. 
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6.4 Using Cine Meter II

Cine Meter II is an economical light and color meter iPhone app, compatible with HELIOS OptiTune. It can be used 
in place of a CRI colorimeter for testing and learning purposes, but it is not suitable for calibrations. It needs to be 
calibrated before use, and its readings can fluctuate when measuring non-continuous light sources like LED video 
displays. Cine Meter II calibrations may thus have an inaccurate color balance and variations in color across the 
tonal scale.

In Cine Meter II, tap Settings (the gear icon), then scroll down to Logging And Web Server. Turn Enable Web Server 
on. The app will display two network addresses, one numerical and the other one based on the device’s name.

In OptiTune’s Preferences, select Cine Meter II colorimeter in Alternate devices. Then, enter either of the network 
addresses in the Cine Meter II address field.

Cine Meter II will now be used as OptiTune’s colorimeter.

For a completely standalone system, select HELIOS Simulator in Preferences. Show the dummy display window, 
and aim Cine Meter II at it (swipe up or right on Cine Meter II’s viewfinder to zoom in as needed). In this way test 
calibrations can be run without either a HELIOS or a CRI colorimeter.
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